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Descriptive type Questions 

D) Answer the following 

Chapter -3 

Charts in Excel-2013 

1. Describe all the components of a chart? 

Ans: 

 Data Table – It refers to the set of data values from which the chart is derived 

 X- Axis – It is the horizontal axis of the chart, also known as the Category axis. 

 Y- Axis – It is the vertical axis of the chart, also known as the Value axis. 

 Chart Title – It helps the user understand what information the chart represents. 

 Axis Titles – It is the Title given to an axis. 

 Chart Area – It refers to the area with in which all chart components are placed. 

 Plot Area – It is the rectangular area bounded by the two Axis. 

 Legend – It identifies the data series. 

 Gridlines – Lines that run across the plot area from each category on the X-Axis and 

from each value on the Y-Axis. 

 Data Label – A Label that provides additional information about a data point on a 

chart. 

2. Write the steps to change the chart type? 

Ans: 

Step 1: Select the Chart. 

Click the Change Chart Type button in the Type Group (or) Chart 

ToolsDesign TabType Group. 

Step 2: The Change Chart Type dialog box appears. 

Step 3: Select a new chart type and the desired layout. Click OK. 

Step 4: The selected chart will appear. 

3. Explain the stock chart using an example? 

Ans: The stock chart generally serves useful for investors, stock companies, and traders to 

analyse the fluctuation in stock prices. 

The data for a stock chart may contain the stock name, stock insurance date, the value of 

stock traded, the opening and closing prices of the stock, and the highest and lowest prices 

of the stock. 

4. List the steps to give light-pink background to chart? 
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Ans: 
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Step 1: Select the Chart by clicking on it. 

Step 2: Click the Shape Fill option in the Shape Style Group. 

Step 3: Then select Light – Pink from the color palette. This will set the background 

color for the chart. 

5. What is a combo chart? How will you create a combo chart? 

Ans: A combination chart is a single chart that plots the series using different chart 

types. 

Step 1: Select the data range. 

Step 2: Click Insert tab Charts Group Recommend Charts. Insert Chart dialog 

box appears. 

Step 3: Click the All Charts Tab. In the Left Pane showing the List of Chart Types, 

Click Combo. 

Step 4: Under Custom Combination, In the Choose the Chart type and Axis for your 

data series panel, Select Clustered column as the Chart type for number of packages. 

Step 5: For Average price, select line as the Chart Type and Select the Secondary 

Axis Check box. Click OK 

 
 

APPLICATION BASED QUESTIONS: 

a. Mudit wants to create chart for the data given alongside (Ref Pg. 55) 

iii. What option should he click in the Charts group on the Insert tab to create a 

suitable chart Recommended Charts Option 

iv. List the steps to create and format the chart. 

Ans: On Clicking the recommended charts option, the insert chart dialog box 

appears. select the chart in the left pane and click ok. The chart will be inserted. 

 To Change the font color for the chart title and the axis title, select them. Click 

the arrow beside the Text Fill option in the Word Art Styles Group and Select 

the Color from the Color Palette. 

 To Set the background color, select the chart as whole by clicking on it. Click 

the Shape Fill option in the Shapes Styles Group and Select the Color from 

the Color Palette 

b. Consider the column chart of English Marks of students in a class, as shown alongside 

(Ref Pg.55). Can you answer the following questions from the chart? 



4  

iv. The range of Marks obtained by maximum number of students 81-90 

v. The range of marks obtained by minimum number of students 41-50 

vi. The total number of students in the class 56 

c. Mohit has drawn a column chart for the data shown on the right (Ref Pg.No.55). His 

teacher has now asked him to convert it to a line chart. 

ii. What should he do to change the chart type? 

Ans: 

 Select the chart. Select the format tab that appears. 

 Type Group  Change Chart Type option. The Change Chart type dialog box 

appears. 

 Select the Chart type – Line in the left pane. 

 Select the Chart in the Right Pane and Click OK. 

ii. How can he move the chart to a new worksheet? 

Ans: 

 Select the chart. Select the format tab that appears. 

 Location Group  Move Chart Option. The Move Chart dialog box appears. 

 Select the New Sheet Option, Type the Name of the New Worksheet and Click ok. 

d. The marks secured by a student in Term 1 Assessment are shown in the table alongside. 

(Ref Pg.No.55). Create a Bar chart and Radar Chart for this data. Then infer which chart 

depicts the data better and why. 

Ans: 

 The Steps to Create a Bar chart are: Select the data. Insert tab Charts Group 

Down arrow of the insert bar chart option. Select the First option of 2-D BAR. The 

Bar Chart is inserted on the worksheet. 

 The Steps to create a Radar Chart are: Select the data. Insert Tab Down arrow of 

the insert Stock, surface, or Stock Chart option and Select First option of the Radar. 

The Radar Chart is inserted on the worksheet. 

 The Bar Chart depicts the data in a better way as it illustrates comparison among 

individual items. The Radar chart plots data in concentric circles. Lines connect 

values from the same series. 



5  

WORKSHEET-1 

A. Who am I? 

6. I am the pictorial representation of data chart 

7. I am a chart which usually compares trends in data at equal intervals Line Chart 

8. I am a chart which shows trends in data over a period of time or illustrates comparisons 

between items Column chart 

9. I am a column chart drawn sideways Bar Chart 

10. I am a chart which plots each data point with a marker Scatter chart 

B. Form the correct word from the below jumbled letters: 

6. GHOUDTUN - DOUGHNUT 

7. DARAR - RADAR 

8. GLENDE - LEGEND 

9. RTAHC LESTYS – CHART STYLES 

10. BINAMOCNIOT - COMBINATION 

C. Word Search 

Find these words in the letter grid given below: 

LEGEND, PIECHART, GRIDLINES, DATALABEL, AXIS 
 

Q W E R A X I S I P U Y E U I O P L P J 

A L S V F H P Y R E W D S F A U A V I K 

E E F S E I U O P L K G N M V C S B E G 

L G K J S F D E R W T Y B E O U Y R C D 

C E D Z A L K B A R D E R T X Z Q B H E 

H N A D A T A L A B E L D E R L I N A Z 

X D C N M R J A C G T O P I U Y T E R V 

Z T R G R I D L I N E S O A S D F M T C 

 
CHAPTER 4 

Advanced Features of Excel 2013 

Descriptive type Questions 

D) Answer the following 

1. How is sorting different from filtering? 

Ans: 

 Once you have entered data in a worksheet, you can change its order. 
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 Changing the order is called sorting of data. Sorting re-arranges data in ascending or 

descending order. 

 You can also filter data, which selectively blocks the data you don’t want to see. 

 Unlike sorting, filtering does not rearrange data. It temporally hides the 

rows/columns you don’t want. You can edit, format, or print the chosen range. 

2. How will you search for your preferred data in a long-filtered list? 

Ans: In case you want a filter a specific value out of thousands of rows of data, you can 

search for your preferred value in the list. 

For Example: In the filter menu of the field name, type ‘A*’ in the search box and click 

ok. All records with name starting with A get filter. 

3. How will you display only those rows in which the total marks obtained by the students 

are greater than 500? 

Ans: The Steps to display only those rows in which the total marks obtained by the 

students are greater than 500 are 

 Select the required cell range 

 Click the home tab. In the editing group, Click Sort and Filter and Select Filter in 

the dropdown list (or) Click the data tab. In the Sort and Filter Group, Click the 

Filter Button 

 Dropdown arrows will appear next to each column headings. You can click any of 

these buttons to apply filter to that field. 

 Click the button of the Total Column and you will be presented with the Filter 

Menu that shows various options. 

 Point two Number Filters in the Filter Menu of the Column Total C. A Sub Menu 

appears. 

 Click Custom Filter. This will open the Custom AutoFilter Dialog box. 

 Select Is display only those rows in which the total marks obtained by the students 

are greater than 500 than and Type 500. Click OK. All the Rows with Total c than 

500 will appear. 

4. What will you do to format the marks above 80 in the cell range A1:D5 in blue? 

Ans: The Steps two format the marks above 80 in the cell range A1:D5 in blue are: 

 Select the cell range A1: D5 

 Click Conditional Formatting in the Styles group on the Home Tab. The Dropdown 

Menu appears. 
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 Point to HighlightCellsRules and click Greater Than in the Sub menu. The Greater 

than dialog box appears. 

 Type 80 in the box on the left and select Custom Format on the right. The Format 

cells dialog box appears. 

 Select the Font Tab. Change the Color to Blue. 

 Click ok in both the dialog boxes, the selected cells get highlighted in the 

worksheet. 

5. Write the steps to print five copies of your worksheet? 

Ans: The steps to print five copies of your worksheet are: 

 Click File – Print. The backstage view will appear showing the Print Pane. The 

Page preview appears on the right side. 

 Select the Printer. 

 Under setting do the following: 

o Select what you want to print. Choose print active sheets. 

o Type the number of copies as 5 

o Select orientation as portrait. 

o Select the page size as A4. 

 Finally click the Print Button. 

Application-Based Questions 

b. Create a worksheet containing the names of students in various sections of classes VI, 

VII, and VIII in your school. Then, sort the list in ascending order of names in each 

section and each class. Write the steps to do this. 

Ans: 

 Select the entire cell range A1: C13 

 Home Tab Editing Group Sort & filterCustom Sort. 

 The Sort dialog box appears. Under Column, Select Class for Sort by. Under Sort on, 

Select Values, and Under Order, Select A to Z. 

 Click the Add Level Button in the dialog box to create an additional sorting level. 

 A New row appears. Under Column, Select Section and Under Order, Select A to Z. 

 Click the Add Level Button again to Create a Third Level Sorting. 

 Under Column, Select Section and Under Order A to Z. 

 Click OK. 
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b. Consider the following worksheet (Refer Pg. No: 71) 

i. Which feature of Excel is shown by the drop-down menu arrows in the column 

heading? Filter Feature 

ii. How many rows will appear if you filter all the records having salary above 50,000? 

Write the Employee No. of. Those records. Two rows, Employee No. of those rows 

are E103 and E104 

iii. How will you turn off this feature in the worksheet? Select Clear in the Sort and 

Filter Menu in the Editing group on the Home tab. 

c. Consider the worksheet given alongside, which shows the status of assignments of each 

student (Refer Pg. No: 71) 

j. Which type of formatting is shown in the worksheet? Conditional Formatting 

ii. Which tab and group has the option for this formatting? Home tab Styles Group 

iii. How will you clear this formatting? 

Ans: 

 Home tab Styles Group Drop down arrow of the Conditional Formatting button. 

 The Sub Menu appears with the options Clear Rules From Selected cells and Clear 

Rules From Entire Sheet. 

 Select the required option 

d. Consider the worksheet shown on the right (Refer Pg. No: 71). Cell B2 has the formula 

to convert temperature given in cell B1 from Celsius to Fahrenheit. 

i. Which feature of Excel is used to get the value of B1 if the value in B2 is 32? Goal Seek 

ii. How will you print this worksheet? 

Ans: 

 Click File Print. The backstage view will appear showing the print pane. 

 Select the Printer. Select Required Settings and Click the Print button. 

WORKSHEET- 1 

B. Who am I? 

5. I am the group on the HOME tab where the Sort & Filter button can be found Editing 

6. I am the feature of Excel 2013 using which one can rearrange the data in the ascending 

or descending order Sorting 

7. I am the feature of Excel 2013 that enables the user to easily view the highest and 

lowest values from a large set of data Custom filtering 

8. I am the tab that contains the Sort & Filter group Data 
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B. Give three facts about the following: 

1. Filtering 

Ans: 

 It is a quick and easy way to find and work with selected data. It temporarily 

hides the rows/Columns which are not required. 

 You can edit, format, or print the chosen range. 

 Excel provides two commands for filtering data ranges: Filter and Advanced 

Filter. 

2. Goal Seek 

Ans: 

 The Goal Seek feature works by providing you the input values as the result when 

you provide the results value as input, the values and cell reference are entered in the 

Goal Seek dialog box. 

 The Goal Seek option is present in the What-If Analysis option, in the Data Tools 

group under the DATA tab. 

 The Goal Seek Status dialog box tells you if Goal Seek was to find a solution. 

C. Crossword 

ACROSS: 

1. This is clicked to open the Custom AutoFilter dialog box. 

2. Click this button, if you have modified the data and want to filter the new data. 

3. This button as the icon in the column heading implies that filter is applied 

DOWN: 

4. Another word for sort. 

5. This is clicked in the Sort & Filter group under the Data tab, to remove the filter 
 

 C U S T O M F I L T E R 

L  E 

 R E A P P L Y  A 

 A  R 

F I L T E R R 

 A 

N 

G 

E 
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Descriptive type Questions 

D) Answer the following 

CHAPTER 5 

Graphics in QBasic 

1. What is the use of the SCREEN Statement? 

Ans: The SCREEN statement is used for selecting an appropriate screen mode for 

creating graphics in QBasic. Screen mode determines the screen resolution that you want. 

2. How many colors can be used as background or foreground in QBasic? 

Ans: There are 16 colors, with values ranging from 0 to 15, which can be used for 

foreground and background colors of the screen. 

3. What is the use of the PAINT Statement? 

Ans: The PAINT statement issued to fill a closed graphic area with a specified color. 

4. What is the difference between B and BF parameter in the LINE Statement? 

Ans: The parameter B will draw a box whereas BF will draw a box filled with color. 

5. Name the 2 Statements that enables us to create and paly sounds in QBasic? 

Ans: The two statements that enable us to create and play sounds in QBasic are 

SOUND and PLAY. 

 
APPLICATION BASED QUESTIONS: 

f. Nishant has written the following code to draw a line from the coordinate (100, 50) 

to (180, 150). 

SCREEN 7 

COLOR 1, 2 

LINE (100, 50) – (180, 150) 

‘Draws a blue line over green Background’ 

iii. Change the program so that you get a rectangle with the same coordinates. 

Ans: 

SCREEN 7 

COLOR 1, 2 

LINE (100, 50) – (180, 150), ,B 

iv. Change the program so that you get a filled rectangle with the same 
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coordinates. 
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Ans: 

SCREEN 7 

COLOR 1, 2 

LINE (100, 50) – (180, 150), ,BF 

g. Simran has written the following the statements to draw circle in QBasic. 

SCREEN 7 

COLOR 14, 0 

CIRCLE (100, 100) ,80 

‘Creates a Yellow Colored CIRCLE over Black background. 

Write the code to draw 2 concentric circles (Having the Same centred but different 

radii) of radii 60 and 40 in Green and Red. 

Ans: 

COLOR 14, 0 

CIRCLE (100, 100) ,60,2 

CIRCLE (100, 100) ,40,4 

h. Consider r the same programming code as given Question b. Re-write the circle 

statement to draw only the Question 1 

i. Lower half of the circle 

Ans: 

SCREEN 7 

COLOR 14, 0 

CIRCLE (100, 100) ,80, ,3.14, 6.28 

 
ii. Upper half of the circle 

Ans: 

SCREEN 7 

COLOR 14, 0 

CIRCLE (100, 100) ,80, ,0, 3.14 

 

i. The following code creates a line in RED 

SCREEN 1 

COLOR 0, 0 

LINE (50, 100) – (200-100), 2 

What change will you do to draw a line GREEN? 

Ans: 

SCREEN 1 

COLOR 0, 0 

LINE (50, 100) – (200-100), 1 
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j. Differentiate between the following statements 

i. SOUND 500, 10 – This statement will make a 500 Hz beep for duration of 10 

ticks. 

ii. SOUND 1000, 10 – This statement will make a 1000 Hz beep for duration of 

10 ticks. 

iii. SOUND 5000, 10 – This statement will make a 5000 Hz beep for duration of 

10 ticks. 

iv. SOUND 10000, 10 – This statement will make a 10000 Hz beep for duration 

of 10 ticks. 

 

WORKSHEET-1 

D. Who am I? 

1. I am a memory area that stores the data temporarily Variable 

2. I am a screen that supports 640 * 350 resolution with two colours Screen 10 

3. I am the QBasic color palette that has red, green, and brown colors Palette 0 

4. I am the command that makes a beep of 1000 Hz SOUND 1000,18 

5. I am the unit of Duration in the SOUND statement Ticks 

E. Form the correct word from the below jumbled letters: 

1. ICLRCE - CIRCLE 

2. DNOSU - SOUND 

3. TNAPI - PAINT 

4. ENSERC - SCREEN 

5. ENNIFSSE - FINENESS 


